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WORKS report template

Installing the template

As a user, you should first save the template into your hard drive in the directory where all your templates were saved.

When you wish to create a new document based on the WORKS report.dot, go to ‘File/New’ on your toolbar, and choose the WORKS report.dot. 

You should start typing your text into this document, using the drop-down list of styles to be found on the formatting toolbar. 

Please do not forget to save your document!

Introduction

Report should be in British English. Use of –ise and not –ize endings, as in words like organise, organisation etc. 

Please use the same Page setup for all the reports. Use the following margins and paper size:

· Margins portrait: 

· top 3,25

· bottom 3,25

· left 2,75

· right 2,75

· header 1,25

· footer 1,25

· Paper size: A4

Text is set in palatino 11pt, line spacing exactly 14pt.

Footnotes are grouped at the bottom of each page and should be numbered continuously throughout the whole text. 

Never write whole words, phrases, titles etc. in capital letters on your keyboard (except the first letter or acronyms, if applicable, of course). It is not necessary to insert full stops in titles such as Dr, Mr, Ms etc. or in acronyms like EU, UNICEF etc.

We recommend minimal use of bold and italics within the text of your paper, as overuse of these can detract from the intended purpose (to highlight key items). 

Quotation marks: the WORKS style is single, with double quotation marks used if there is a second quotation within the first. Do not use italics and quotation marks together.

Numbers between one and twenty inclusive should be written out in full. Numbers from 21 up should appear as figures. Numbers from 1,000 upward should have a comma. Decimal points are written as full stops (not commas).

Structure of your contribution

Use the decimal system to structure your text. Only 2 or 3 decimal digits should be used. For example:

1.1
Costs and benefits

1.1.1
Cost-benefit

1.1.1.1
Selected research results

The cover

The cover is in picture format with text boxes in it to add the relevant information. Go to the ‘View’/‘Page layout’ in order to view the text boxes and to add the title/subtitle of the report and the authors.

Use of styles

The WORKS template (see attachment, WORKS report.dot) provides defined styles in order to ensure that the WORKS reports will have a consistent quality. These styles are easy to follow and you can either type your content first and then apply the style or click on the appropriate style prior to typing each section. 

Use the Style area width option from the View tab of the Options item from the Tools menu in Word to view the styles used within the document. The view has to be set at Normal (by selecting Normal from the View menu in Word).

Glossary of styles in the WORKS report template

Style
Function

Heading 1
Used for the title (level 1) of a chapter. Type all headings with an initial capital letter for the first word only

Heading 1b
Used for a subtitle of a chapter

Heading 1c
Used to denote the author of the chapter

Heading 2
Used to indicate a level 2 (1.1) heading within the document

Heading 3
Used to indicate a level 3 (1.1.1) heading within the document

Heading 4
Used to indicate a level 4 (1.1.1.1) heading within the document

Heading 7
Used for the heading of a table or figure

Normal
Used for a standard paragraph of text. After heading 2, heading 3, heading 4, heading 5, tables, figures, box, bulleted and numbered lists you always use Style ‘normal’

Normal Indent
Used for each subsequent paragraph 

NR
Used to place an item in a numbered list

R1
Used for a subparagraph to a numbered list

R2
For bulleted sublists under a numbered list

N1
Used to place an item in a bulleted list

L1
Used for a subparagraph to a bulleted list level 1 (N1)

N2
For bulleted sublists

L2
Used for a subparagraph to a bulleted list level 2 (N2)

AU
Used to denote a bibliographical reference

Box
Used for quotes, notes or paragraphs of special interest 

Header
Used for the header of a document

Footer
Used for the footer of a document

Page number
Used for the page number in the footer

Footnote reference
Used for a footnote reference. The reference number should ideally be placed at the end of the sentence after the full stop. You should number footnotes consecutively through the whole work and not separately within chapters

Footnote text
Used for footnote text. Use your PC default settings to add footnotes at the bottom of a page. Do not put bibliographical references in footnotes

Figure
Used for figures/graphs

Figure source
Used for a figure/graph source

Table
Used for a table

Table remark
Used for a table remark

Table source
Used for a table source

TOC1
Used for a level 1 heading in a table of content

TOC2
Used for a level 2 heading in a table of content

TOC3
Used for a level 3 heading in a table of content

Tables and figures 

All tables and figures should be numbered by reference to section numbers (e.g. Table 1.1, Table 1.2 or Figure 1.1, Figure 1.2 etc.). Table and figure captions should be placed above the table/figure. Place tables and figures as close as possible to where they are mentioned in the text and not at the end of your chapter. No part of a table or figure should go beyond the typing area and both should be started from the left margin (not centered).

Tables should be simplified as far as possible. Vertical rules should be avoided. Abbreviations may be used to save space, but only where the meaning is immediately clear. Spaces with no figures should have dashes, and ditto marks should be avoided. Decimal fractions should be preceded by a zero.

Where a table has a single note an asterisk should be used. For more than one note raised letters a, b, c, d are used.

Use only Word for your tables. For figures you can use Harvard Graphics (or Excel). If you use other formats than Word for your figures, please send us separately a hardcopy of the respective illustrations in a reproducible form for publication. 

Do not use colours in your reports. The reports will be printed in black and white.

To add a table in your text, type ‘table’ and press ‘F3’ (or choose Table in the Autotext item from the Insert menu). All (possible) styles for a table than appear. 

Table .1


*


Source:


Table 1.1
Title of table – use ‘heading 7’ style


Decreases (strongly)
Remains constant
Increases (strongly)
M
s
N*

Population growth
18
25
57
3.5
1.0
1,520

War
14
54
32
3.2
0.8
1,438

Women’s inequality
80
17
4
2.1
0.7
1,465

Note: 
For a table remark, use the style ‘table remark’.

Source: Use ‘table source’ style for sources 

To add a figure in your text, type ‘Figure’ and press ‘F3’ (or choose Figure in the Autotext item from the Insert menu). All (possible) styles for a figure than appear. 

Figure .1


Source:


Figure 1.1
Title of figure – use ‘heading 7’ style
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About the table of contents

This report template is complete with Styles for a table of contents. From the Insert menu, choose Index and Tables. Click on the tab you would like. Be sure to choose the format ‘From template’.

Always check if Show levels stays on 3. This means all the headings (1-3) will be automatically integrated in the table of contents. 

Bibliography

Please leave literal quotations in their original language. 

General rules:

· The bibliographical list should be sorted in alphabetical order.

· Source of the information on authors/title etc. is the inside cover page and the bibliographical reference in the document referred to.

· Names of authors/institutions etc. should be written in regular font (no capitals, bold letters etc.). For the first name, use initials only (no comma between last and first name). Separate two authors by a comma. 

· Use only lower case initial letters in the titles (except those words that must be written with capital initials (e.g. names, countries etc.). Example: NOT: Career Mobility Dynamics in Europe, BUT: Career mobility dynamics in Europe.

· Do not forget to indicate the publisher before the publication place.

Components of a reference 

For a book (or contributions to a book), you will need to find out and record (items in brackets will not apply in all cases): 

· (Name of chapter author in edited text) 

· Year of publication of edition used 

· (Chapter title of edited text) 

· Name of book's author(s)/editor(s) 

· Book title and subtitle if any

· Edition 

· (Series, if relevant and useful) 

· Publisher 

· Place of publication 

For books: Author Initials (Year), Title of book, Edition. (Series title), Publisher, Place of publication.

Examples:

Altvater E. & Mahnkopf B. (2002), Globalisierung der Unsicherheit - Arbeit im Schatten, schmutziges Geld und informelle Politik, Westfälisches Dampfboot, Münster.

Andreasen L.E., Coriat B., Den Hertog J.F. & Kaplinsky R. (eds.) (1995), Europe’s next step: organisational innovation, competition and employment, 2nd edition, Frank Cass & Co., New York.

Anxo D. & O’Reilly J. (2000), ‘Working time regimes and transitions in comparative perspective’, in J. O’reilly, I. Cebrián & M. Lallement (eds.), Working time changes. Social integration through transitional labour markets, Al​dershot.

Appelbaum E., Bailey T., Berg P. & Kallenberg A. (2000), Manufacturing advantage: why high per​form​ance work systems pay off, Cornell University Press, New York.

Belbin M. (2000), Beyond the team, Butterworth-Heinemann, Oxford.

Benders J. & Van Hootegem G. (2000), ‘How the Japanese got teams’, in S. Procter & F. Mueller (eds.), Teamworking, MacMillan Press, London, p. 1-24.

European Commission (1997), Partnership for a new organization of work. Bulletin of the European Union ‑ Green Paper, Supplement 4/97, Office for the Official Publications of the European Communities, Luxembourg.

For a journal article, you should ascertain: 

· Name of author(s) 

· Year of publication 

· Article title 

· Journal title (in full) 

· Week, month or season of publication 

· Volume and issue numbers 

· Inclusive page numbers of article 

For articles: Author Initials (Year), ‘Title of article’, Full Title of Journal, Volume number, Issue number, Pages.

Examples:

Berg P., Appelbaum E., Bailey T. & Kallenberg A. (1996), ‘The performance effects of modular pro​duction in the apparel industry’, Industrial relations, vol. 35, n° 3, p. 1-13.

Barrett E. (1996), ‘Justice in the workplace?’, Personnel Review, vol. 28, n° 4, p. 2-14.

Delbridge R., Lowe P. & Oliver N. (2000), ‘Shopfloor responsibilities under lean teamworking’, Human relations, vol. 53, n° 11.

Referencing the world wide web 

· Author(s) (this might be an individual or institution, e.g. a university department) 

· Year of publication 

· Title of item/article

· Publisher 

· Place of publication 

· Source's URL (see below) 

· Date the source was last updated or modified 

· Date you accessed the source 

Example

O’Reilly J., Cebrián I. & Lallement M. (eds.), Working time changes. Social integration through transitional labour markets, http://www.hiva.be/ (last updated 12 December 1998; accessed 30 June 1999).

European Foundation for the Improvement of Living and Working Conditions (2002), Quality of work and employment in Europe. Issues and challenges, European Foundation for the Improvement of Living and Work​ing Conditions, Dublin, http://www.eurofound.ie/publications/files/EF0212EN.pdf (last updated 12 December 1998; accessed 30 June 1999).

For papers: 

· Name of author(s) 

· Year of publication 

· Paper title 

· Name event 

· Name event organiser 

· Place of event

· Date of event

Examples:

Kelliher C. & Gore J. (2002), ‘Functional flexibility and the intensification of work: transformation within service indus​tries’, Paper presented at the Intensification of work conference, the Centre d’Etudes de l’Emploi, Paris, November.

Lansbury R.D. & Pickersgill R. (2000), ‘Training, social dialogue and industrial relations: an international perspective’, Paper presented at the 9th VET Research conference/workshop, NCVER & North Coast Institute of TAFE, Coffs Harbour, New South Wales, 4-7 July 2000.

Citations to bibliographical references in text

Citations to references should be designated throughout the text by enclosing the authors' names and the year of the reference in parentheses. Example: 

Several studies (Adams, 1974: 5; Brown & Hales, 1975, 1980; Collins, 1976a,b) support this conclusion. 

Note the use of alphabetical order and an ampersand in citations. 

If there are more than two authors or editors of a book or article, cite both names every time the work is cited in the text. If the work has more than two authors, cite all authors the first time the reference occurs; in subsequent citations of the same work, include only the surname of the first author followed by ‘et al.’ (not underlined) and the year. Examples: 

Few field studies use random assignment (Franz, Johnson & Schmidt, 1976). 

[first citation] 

...even when random assignment is not possible" (Franz et al., 1976: 23). 

[second citation] 

However, for works with six or more authors, use only the surname of the first author followed by et al. whenever the work is cited. 

In the listing at the end of your work, you are, however, expected to include all the authors’ names, unless there are seven or more, in which case give only the first three followed by et al.

Good luck with your report. If you require further guidance preparing your reports, please contact Sandra Volders – sandra.volders@hiva.kuleuven.be.

Example of a report in the WORKS report template
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1
Project summary 

Work Organisation and Restructuring in the Knowledge Society

Monique ramioul

WORKS is an IP with 17 EU and Accession State partners to carry out research on how employment, learning and labour practices adapt to change and with what effect. Taking account of the global context and of regional diversity within Europe, the project will: integrate knowledge on changes in work in the KBS; analyse existing quantitative data, identify best practices and develop a roadmap for convergence; carry out organisational case studies to provide windows into the restructuring of value chains at strategic points to illuminate changes in the organisation of work within and between organisations; carry out qualitative research at the individual level in order to analyse the quality of work, time use, learning and occupational identities; carry out a comparative regional mapping of the institutional, policy and social dialogue aspects of workplace changes and their impact on organisations and individuals; establish a Global Reference Group to compare European developments with those elsewhere and to identify the niches of European regions in the new global division of labour in the knowledge economy; develop methodologies for carrying out qualitative research into work organisation which are sufficiently rigorous to allow for comparability whilst retaining sensitivity to cultural and institutional differences; contribute to the development of an integrated ERA by involving researchers from outside the project and by contributing to the training of researchers; actively involve the social partners and other policy stakeholders in the project; include the future perspective grounded in robust empirical research, take account of regional diversity and the differing interests of social actors and avoid crude extrapolation; take account of gender, ethnic and other social variables within as well as between sectors, regions, organisations, workplaces and households and, finally, disseminate the results to the policy and research communities.

2
Scientific and technological objectives of the project 

Objectives of the project

sandra volders

2.1
The main objective of WORKS

One of the underlying assumptions of the WORKS proposal is that the reorganisation of work can only be understood fully in the context of a global restructuring of value chains, entailing a simultaneous decomposition and recomposition of sectors, organisations, labour processes and skills. However, the considerable heterogeneity within Europe of skill supply, levels of employment, welfare systems, and economic sectors make it especially difficult to disentangle the causes and effects of such processes and to isolate the primary drivers of change. Yet it is particularly important for Europe both to understand the factors underlying economic restructuring (and hence the competitiveness of European firms) and to examine their quantitative and qualitative impact on working conditions and social welfare. Further, Europe not only faces the future from a highly fragmented base but its research in this area is similarly fragmented. This research project is designed to overcome this, and to produce knowledge and recommendations specifically geared to the problem of organisational development in a period of rapid change. At the heart of this is a single issue: how are employment practices adapting to change and with what effect? If we can answer this more effectively on a Europe-wide basis we will be able to propose practical solutions to real problems. 

The main objective of the WORKS project is to improve the understanding of changes in work in the knowledge-based society (KBS), their driving forces and their implications for the use of knowledge and skills and for the quality of life. In particular, new forms of work organisations will be analysed taking account of global value chains and regional institutional contexts. 

Why do we propose such a multi-faceted approach? Our argument is that the research base needs to innovate in a more comprehensive inter-linking of different issues, different research approaches, and different disciplines if it is to contribute something of value. The real world is now so complex that research on the factors driving change, and assessment of the effects of change, can no longer be compartmentalised. The project is rooted in the following assumptions:

1.
the workplace forms a crucial locus where the individual citizen encounters global economic forces. However, the interactions between the individual and the global which take place in the workplace are neither inevitable nor uni-directional. Work organisation is shaped interactively both by structural forces and by the agency of individuals at a local level. It is therefore necessary to combine the study of institutions with that of individuals;

the ‘knowledge society’ is rooted in the ‘knowledge-based economy’, but there are both continuities and discontinuities with the ‘old economy’. The processes which accompany technological change bring about structural changes in the economy, a complex restructuring of traditional manufacturing and service sectors, and new patterns of cross-sectoral trade in services. Thus research should not be restricted too narrowly defined ‘knowledge sectors’. A key concept here is that of the elaboration of value chains, both spatially and contractually;
· these developments are accompanied by (and in some cases enabled by) the codification of skills and knowledge leading simultaneously to new forms of flexible and autonomous ‘knowledge work’ but also to new forms of Taylorism;

· these developments are accompanied by (and in some cases enabled by) the codification of skills and knowledge leading simultaneously to new forms of flexible and autonomous ‘knowledge work’ but also to new forms of Taylorism;

2.
the accompanying changes in technology and work organisation are leading to new patterns of learning, both formal and informal, resulting in a dual process of decomposition and recomposition of skills and occupational identities;

3.
as well as transforming production and business processes and generating new products and services, these developments also transform consumption processes, creating new types of unpaid activity and thus impacting on domestic as well as working life. These impacts interact with the impacts of changing household structures and changing gender patterns of labour market participation;

2.2
Detailed description of project goals, means to achieve them and measures of progress

2.2.1
Goal 1: Integrating the existing knowledge on changes in work in the knowledge-based society. To review the state-of-the-art in respect of concepts, theories and empirical research on changes in work in the KBS in Europe

This will involve:

· a comprehensive overview of research traditions and a synthesis of research findings;

· a systematic interaction with the new scientific developments in each of the countries involved and at the European level during the project’s lifetime.

2.2.2
Goal 2: Mapping and assessing the exploitation of existing quantitative data sources of the National and European Statistical System, including the development of a roadmap for more convergence of instruments to measure changes in work in the KBS at the European level

This will involve:

· a feasibility and benchmarking study of the national and European statistical systems regarding the quantitative analysis of changes in work in organisation and in individual and household surveys;

· the identification of problems of comparability of the different data bases and the strengths and weaknesses of the national and European data bases.

2.2.3
Goal 3: Innovating the knowledge on changes in work and the quality of life by carrying out qualitative research on work organisation, use of knowledge and skills and quality of working life in selected business functions or activities at organisational and networks level

This will involve:

· the development of an appropriate internationally comparative qualitative research methodology on organisations;

· the investigation in case study research of 58 organisations in 13 participating countries.

3.
Participant list

WORKS consortium

Gerard valenduc

Table 3.1
Participant list

Part. role*
Part. number
Part. name
Part. short name
Country
Date enter project
Date exit project

CO
1
Katholieke Universiteit Leuven (Catholic University of Leuven), Hoger Instituut voor de Arbeid (Higher Institute for Labour Studies)
K.U.LEUVEN
Belgium
01/06/05
31/05/09

CR
2
Forschungs- und Beratungsstelle Arbeitswelt (Working Life Research Centre)
FORBA
Austria
01/06/05
31/05/09

CR
3
London Metropolitan University, Working Lives Research Institute
LONDONMET
UK
01/06/05
31/05/09

CR
4
Fondation Travail-Université, Work & Technology Research Centre
FTU
Belgium
01/06/05
31/05/09

CR
5
Panteion University of Political and Social Sciences, Department of Social Policy & Social Anthropology of Panteion
UPSPS
Greece
01/06/05
31/05/09

CR
6
University of Twente, School of Business, Public Administration & Technology
UT
Nether​lands
01/06/05
31/05/09

CR
7
University of Essex, Institute for Social and Economic Research
UESSEX
UK
01/06/05
31/05/09

CR
8
MTA Szociológiai Kutatóintézete, Institute of Sociology of the Hungarian Academy of Sciences
ISB
Hungary
01/06/05
31/05/09

CR
9
Institut für Sozialwissenschaftliche Forschung e.V.
ISF MUENCHEN
Germany
01/06/05
31/05/09

CR
10
Forschungszentrum Karlsruhe GmbH, Institute for Technology Assessment and Systems Analysis
FZK
Germany
01/06/05
31/05/09

CR
11
Fundação da Faculdade de Ciências e Tecnologia-UNL 
FFCT-UNL
Portugal
01/06/05
31/05/09

CR
12
National Institute for Working Life, Department for Research on Development Processes 
NIWL
Sweden
01/06/05
31/05/09

CR
13
Istituto di Ricerche Economiche e Sociali 
IRES
Italy
01/06/05
31/05/09

CR
14
Stiftelsen for industriell og teknisk forskning ved Norges tekniske høgskole, Industrial Management 
SINTEF
Norway
01/06/05
31/05/09

CR
15
Arbetstagarkonsultation AB, Arbetsliv
ATK
Sweden
01/06/05
31/05/09

CR
17
Centre d’études et de l’emploi 
CEE
France
01/06/05
31/05/09

CR
19
Bulgarian Academy of Sciences, Institute of Sociology,
IS
Bulgaria
01/06/05
31/05/09

Source: HIVA, 2005

4.
Relevance to the objectives of Priority 7

Changes in work in the knowledge society

Jorg flecker

4.1
Contribution to the programme objectives

The primary aim of the WORKS project is to cover topic ‘2.1.3 Changes in work in the knowledge society’ fully and exclusively. Thus the project will contribute to:

· ‘understand the major changes in work’ by investigating the dynamics of work organisation and employment;

· ‘in a future perspective’ by applying a process view and including the future perspective as a main stream in the project activities;

‘the relationships of these changes to the use of knowledge and skills’ by analysing the development and the application of knowledge and skills in the work organisation as influenced by the institutional context;

· ‘and their implications for quality of life’ by investigating, in particular, working conditions and the work/life balance from an organisational, individual and household point of view;

‘and their implications for quality of life’ by investigating, in particular, working conditions and the work/life balance from an organisational, individual and household point of view;

· ‘and their implications for quality of life’ by investigating, in particular, working conditions and the work/life balance from an organisational, individual and household point of view.

To reach this aim this proposal suggests a comparative analysis of changes in work organisation as shaped by major driving forces including the dynamics of global value chains and other forms of restructuring, taking into account the variety of institutional and policy contexts in the EU member and Accession Countries. The project will analyse different ways of achieving flexibility and, partly related to this, changes in the use of knowledge and communication considering explicit and tacit forms of knowledge, spatially distributed work and the dynamics of the use of ICT. The examination of new forms of work organisation, including network organisations and employees’ self-organisation, is at the core of the project. 

One major aim in this is to analyse, by way of focusing both on organisations and occupational groups on the one hand, and individuals and households on the other, the impact of new forms of work organisation on the quality of life, both within the work environment and outside, by investigating core aspects of working and living conditions. These include the use of time and work/life balance as well as the learning opportunities, occupational identities and aspects of income and biographical security. Social dialogue aspects are included by analysing the dynamics of organisational change and the shaping of work organisation and quality of life in an institutional context. A well-grounded future perspective will be reached based on the acquired knowledge on drivers of change, including the strategies of relevant actors, on the dynamics of organisational development, and on the impacts on the quality of life.

4.2
State-of-the-art of research in relevant fields 

This state-of-the-art review is organised round ten distinct but inter-related themes which reflect the literature. All of the work packages proposed in WORKS will build on several of these themes, and all themes will be covered somewhere in WORKS. These themes are: the knowledge society; globalisation and the elaboration of value chains; public policy and social dialogue; new forms of work organisation in the knowledge-based society; new career trajectories; the use of knowledge and communication; occupational change and the demand for skills; the gender dimension; quality of life; and future trends.

5.
Outline implementation plan 

For the full duration of the project

Ursula Huws

5.1
Activities

5.1.1
Introduction

The main research components of the project are research and innovation activities focused on broadening, integrating and innovating knowledge in Europe and beyond on changes in work in the knowledge-based society. This will at the formal level be achieved through a comprehensive, multi-faceted and yet closely controlled set of research activities:

· writing state-of-the-art papers about theory, concepts, research and policies in the different countries and regions involved, and at the European level. This is mostly based on document study and desk research (subgroup ‘Theory and concepts’, subgroup ‘Policy, institutions and social dialogue’);

· undertaking comparative quantitative analysis of data based on existing data bases (subgroup ‘Quantitative analysis’).

The critical and distinctive aspects of this, however, are the goals of introducing analysis around fluid concepts such as occupations in change and business functions. These substantive points mean that, on the secure foundation just described, the research can move freely through its content matter by not getting fixed on rigid or potentially obsolete aspects of current work organisation. This flexibility, combined with both horizontal and vertical approaches to aspects of organisational change, is a major step forward. 

5.1.1.1
Subgroup ‘Theories and concepts’
WP3: State-of-the-art on concepts, theories and research on changes in work (co-ordination: LONDONMET - IRES)

In order to bring together the huge variety of research traditions and the most recent empirical, conceptual and theoretical knowledge throughout Europe, the partners, fully reflecting European diversity will prepare papers on the state-of-the-art, representing the different regions and/or language groups in Europe. This state-of-the-art also includes a European level state-of-the-art, aiming at taking account of relevant European projects. Further, a special state-of-the-art paper on the future perspective will be prepared.

This work includes theoretical approaches; conceptual frameworks and comparative models; and the collection, analysis and benchmarking of empirical results of qualitative and quantitative research such as organisational research on changes of work in different economic sectors and research on individual behaviour and outcomes (e.g. time use, skill development, quality of working life, work/life balance, and occupational identities). Attention will be paid to crosscutting issues such as patterns of gender and ethnic segregation as well as the regional dimension.

In this respect a systematic interaction with the new scientific developments in each of the countries involved and at the European level will be achieved during the project’s lifetime.

5.1.1.2
Subgroup ‘Quantitative analysis’
WP4: Feasibility study and benchmarking of the national and European statistical system with respect to the quantitative analysis of changes in work, including the development of a roadmap and related initiatives for more convergence of instruments to measure changes in work in the KBS at the European level (co-ordination: K.U.LEUVEN - UESSEX)

The aim of this work is to organise a state-of-the-art overview of the existing statistical sources in the different European countries and at the European level. The analysis will focus on the extent to which these sources and data bases make it possible to monitor changes of work quantitatively. Objectives of this research phase are the systematic mapping of European organisations and individual/household surveys that are relevant to measure changes in work; identification of indicators for further use in the project, investigation of the accessibility and feasibility of using existing data bases, assessment of problems of comparability across different data bases, and examination of the strengths and weaknesses of the national and European statistical systems with regard to the issues addressed in the project. 

Although organisation surveys and individual/household surveys are different in nature, it is important to provide clear links between them. These will be established by the subgroup structure that ensures co-operation between the two quantitative parts of the project. This is necessary for instance to ensure equivalent occupational and sectoral definitions, and that information on organisational change elicited in one are of work is tested in the other. Such a link is necessary to understand the relationship between changes on the labour market and the pressures on organisations emanating from globalisation, technological changes and policies to develop ‘human capital’ within organisations. Moreover, some means are needed to disseminate key findings from both survey studies. This will ensure that the quantitative work meets the needs of the project, that the organisational and individual research outputs are linked in order to maximise synergies, and that the results are then fed into other parts of the project’s research. While overall control of the organisational and individual analyses are combined, these two survey types do also need different strategic approaches to meet the objectives.

5.2
Plans

5.2.1
Plan for using and disseminating knowledge

5.2.1.1
Use of knowledge

The management of knowledge and intellectual property is described in detail in the project’s Consortium Agreement. The main principles and provisions are as follows:

Principles of copyright

The copyright of each partner in copyright-protected work remains with the author himself or herself. The same holds for co-workers of the individual partner. If several authors are involved in the work, then in case of doubt each holds an equal share of the copyright. Authors always have the right to be fully acknowledged for their authorship. 

Works external to the project

In the case that the partners utilise copyright-protected works for the aims of the project and these works have not been drawn up within the project, but the rights thereto have accrued independently of the project, then all rights belong exclusively to the respective partner. The use of such works by other partners requires the express agreement of the entitled. 

In the case that such copyright-protected works are introduced into the project and made available for use it will be assumed that the partner in question is granting the unrestricted use of the work. This also holds expressly for data bases. Otherwise the entitled partner shall be obliged expressly to restrict particular rights of use with regard to the partner and to disclose any existing third-partner rights.

6.
Project management

WORKS management

Monique ramioul

Based on the involvement in several European Research projects of all of the participants, of which some have been Project Co-ordinators (Gerard Valenduc, Monique Ramioul, Ursula Huws, Jörg Flecker, Antonio Moniz, Per Tengblad, Steve Jefferys, Giovanna Altieri, Csaba Makó, Malcolm Brynin), the partners in the consortium have built up extensive experiences and practices related to European Research and are indeed part of an established European Research Area on the topics addressed in the call, due to their involvement in several consecutive and interrelated projects. This experience relate both to the management structure to organise European Research in an effective and efficient way, and to the management of knowledge creation, of Intellectual Property Rights, management issues and dissemination activities. In the frame of these research activities, fair and workable management structures and Consortium Agreements have already been established and proved to be effective ways of managing these issues. The management structure for WORKS is however adapted in order to meet the requirements of an Integrated Project that includes as well a large consortium of 17 European partners with a wide variety of expertises, as a broad range of activities, including research, training and global dissemination. 

6.1
Project management

Specific attention will be focused on all integration activities. In order to handle the complexity of management tasks arising with this Integrated Project, both the organisational and administrative structure of the Project need to be carefully implemented. The management structure consists of five different levels:

· the Scientific Board consisting of the Subgroup Leaders, chaired by the co-ordinator;

· the Global Reference Group including policy and scientific representatives beyond the project.

The general project is organised based on the five main pillars or subgroups of the project, each consisting of different work packages. The five project pillars/subgroups are:

1.
the integration and innovation of theories and concepts (subgroup ‘Theory and concepts’);

2.
the global dissemination activities beyond the project and the consortium as a main responsibility at the level of the Scientific Board (subgroup ‘Global dissemination’).

Figure 7.1
Project management
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